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関連資料: 完全なリストについては、ここをクリックしてください。 

本アプリケーション ノートの最新版または関連プロジェクト ファイルについては、

http://www.cypress.com/go/AN54181 へアクセスしてください。 

更にコード用例をお求めでしょうか？以下の通りご対応いたします。 

PSoCのコード用例のリストにアクセスするには、コード用例のウェブページをご覧ください。PSoC 4の

ビデオ ライブラリについてはここからご覧ください。 
  

AN54181 では、8051 ベースのプログラム可能なシステム オン チップである PSoC® 3 についてご紹介いたします。本資料は、

PSoC 3 アーキテクチャとその開発ツールについて説明する他、PSoC Creator™という PSoC 3 用の開発ツールを使用して

簡単なデザインを作成する方法をご案内します。また、本アプリケーション ノートは PSoC 3 を始め、一般的な PSoC を深く 

理解できるようなリソースを提供します。 
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1 はじめに 

PSoC 3は、単一のチップ上にカスタムのアナログとデジタル ペリフェラル機能, メモリ, および 8051 CPU を集積した、真の 

プログラマブルな組込みシステム オン チップです。 

PSoC 3 は、MCU と外部 IC の組合せに代わるコスト効率の良いソリューションを提供しています。PSoC 3 アーキテクチャは下
記によって性能を向上させます。 

▪ 8ビットの 8051コア、および DMAコントローラーとデジタル フィルター プロセッサ、動作速度は 67 MHzまで 

▪ 超低消費電力、業界最大の電圧範囲に対応 

▪ プログラマブルなデジタルおよびアナログ ペリフェラルでカスタム機能を実現可能 

▪ 任意のアナログまたはデジタル ペリフェラル機能から任意のピンまでの柔軟性の高いルーティング 

単一の PSoC デバイスに 100 個までのデジタルおよびアナログ ペリフェラル機能を統合することができ、設計時間, 基板面積,  

消費電力, およびシステム コストを削減しながら、システムの品質を向上させます。 

http://www.cypress.com/
http://www.cypress.com/go/AN54181
http://www.cypress.com/documentation/code-examples/psoc-345-code-examples
http://www.cypress.com/video-library/PSoC
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 本書の使用法 

これより数ページで PSoC 3 および PSoC と PSoC Creator で設計する利点について説明します。ただし、はじめての PSoC 3 

デザインまでとばして、直ちに簡単なデザインをビルドすることもできます。そのセクションで作成したデザインは 

サンプル コード CE203303にも掲載されます。 

2 PSoC リソース 

サイプレスは、www.cypress.comに大量のデータを掲載しており、ユーザーがデザインに対して適切な PSoCデバイスを
選択し、迅速かつ効率的にデバイスをデザインに統合する手助けをしています。リソースの包括的なリストについては、 

「KBA86521, How to Design with PSoC 3, PSoC 4, and PSoC 5LP」をご参照ください。以下は PSoC 3のリソースの要約です。 

▪ 概要: PSoCポートフォリオ、PSoCロードマップ 

▪ 製品セレクター : PSoC 1, PSoC 3, PSoC 4, 

PSoC 5LP, または PSoC 6 MCU。また、PSoC 

Creator にはデバイス選択ツールも含まれてい

ます。 

▪ データシート: PSoC 3, PSoC 4, PSoC 5LP, お
よび PSoC 6 MCU デバイス ファミリの電気的
仕様を説明します。 

▪ CapSense® デザイン ガイド: PSoC 3, PSoC 4, 

PSoC 5LP, および PSoC 6 MCU ファミリのデ

バイスを使用して静電容量タッチ センシング アプ

リケーションを設計する方法について説明します。 

▪ アプリケーション ノート およびサンプル コード: 

基本的なレベルから高度なレベルまでの幅広い

トピックに触れています。アプリケーション ノート

の多くはサンプル コードを含んでいます。 

▪ テクニカル  リファレンス  マニュアル  (TRM): PSoC 3, 

PSoC 4, PSoC 5LP, および PSoC 6 MCUデバイス ファ
ミリのアーキテクチャとレジスタの詳細な説明を提供しま
す。 

▪ PSoC トレーニング動画: これらの動画は PSoCを用いて、
複雑なデザインを作成するステップ バイ ステップ方法を
提供します。 

▪ 開発キット: 

 CY8CKIT-030はアナログ性能用に設計されています。

これにより、高精度アナログ, 低消費電力, かつ低電

圧のアプリケーションを開発し、評価することが可能に

なります。 

 CY8CKIT-001 は、PSoC 1, PSoC 3, PSoC 4, また

は PSoC 5LP アーキテクチャのいずれかを使用して

開発した異なるソリューションを試作し評価する共通

開発プラットフォームを提供します。 

3 PSoC Creator                    

PSoC Creatorは無料のWindowsベースの統合設計環境 (IDE) です。このキットにより、PSoC 3, PSoC 4, PSoC 5LP, お

よび PSoC 6 MCU ベースのシステムのハードウェアとファームウェアの同時設計ができます。図 1 に示すように、PSoC 

Creatorにより、以下のことを実行できます。 

1. コンポーネントをドラッグ＆ドロップして、メイン 

デザイン ワークスペースでハードウェア システム

を構築 

2. PSoC ハードウェアとアプリケーション ファーム

ウェアを同時設計 

3. コンフィギュレーション ツールを用いてコンポー

ネントを構成 

4. 100以上のコンポーネントを含むライブラリを利用 

5. コンポーネント データシートをレビュー 

http://www.cypress.com/
http://www.cypress.com/node/386956
http://www.cypress.com/
http://www.cypress.com/?id=4&rID=77024
http://www.cypress.com/psoc
http://www.cypress.com/?rid=95697&source=cexxxxx
http://www.cypress.com/?id=1573&source=cexxxxx
http://www.cypress.com/?id=5041&source=cexxxxx
http://www.cypress.com/?id=4976&source=cexxxxx
http://www.cypress.com/?id=5044&source=cexxxxx
http://www.cypress.com/search/psg/114026
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=resource_meta_type%3A575&f%5b2%5d=field_related_products%3A1292
http://www.cypress.com/search/all/capsense?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=resource_meta_type%3A574&f%5b2%5d=field_related_products%3A1292&f%5b3%5d=field_related_products%3A1307&f%5b4%5d=field_related_products%3A1297
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=resource_meta_type%3A574&f%5b2%5d=field_related_products%3A1292&f%5b3%5d=field_related_products%3A1307&f%5b4%5d=field_related_products%3A1297
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=software_tools_meta_type%3A579&f%5b2%5d=field_related_products%3A1292&f%5b3%5d=field_related_products%3A1307&f%5b4%5d=field_related_products%3A1297
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=resource_meta_type%3A583&f%5b2%5d=field_related_products%3A1307&f%5b3%5d=field_related_products%3A1297&f%5b4%5d=field_related_products%3A1292
http://www.cypress.com/video-library/PSoC
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=field_related_products%3A1307&f%5b2%5d=software_tools_meta_type%3A577&f%5b3%5d=field_related_products%3A1292&f%5b4%5d=field_related_products%3A1297
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-030-psoc-3-development-kit
http://www.cypress.com/?rID=51577&source=ce95314
http://www.cypress.com/psoccreator/?source=cexxxxx
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図 1. PSoC Creatorの特長 

 

3.1 PSoC Creatorヘルプ 

PSoC Creator ホームページへアクセスして PSoC Creator の最新版をダウンロードしてください。次に、PSoC Creator を 

起動して、以下の項目を開きます: 

▪ クイック スタート ガイド: Help > Documentation > Quick Start Guide を選択します。このガイドは PSoC Creator 

プロジェクトを開発するための基礎知識を提供します。 

▪ 簡単なコンポーネント サンプル プロジェクト: File > Open > Example projects を選択します。これらのサンプル プロ

ジェクトは、PSoC Creatorのコンポーネントの設定と使用方法を示します。 

▪ 初心者向けの設計: File > New > Project > PSoC 3 Starter Designsを選択します。これらの初心者向けのデザイン

は、PSoC 3のユニークな機能を説明します。 

▪ システム リファレンス ガイド:  Help > System Reference > System Reference Guide を選択します。このガイドは、

PSoC Creatorが提供するシステム機能を記載し説明します。 

▪ コンポーネント データシート: コンポーネントを右クリックして「Open Datasheet」を選択します。すべての PSoC 3 コン 

ポーネント データシートの一覧については、PSoC 3コンポーネント データシートのページへアクセスしてください。 

▪ ドキュメント  マネージャー : PSoC Creator は、ドキュメント  リソースを容易に検索し確認するために、Document 

managerを提供します。Document Managerを開くには、メニューから Help > Document Managerを選択します。 

3.2 テクニカル サポート 

ご質問がございましたら、弊社のテクニカル  サポート チームが対応致しますので、お気軽にご連絡ください。Cypress 

Technical Supportページにアクセスし、お問い合わせ内容をご記入ください。 

米国のお客様は、弊社フリーダイヤル (+1-800-541-4736 ext.8) までお電話いただければ、弊社のテクニカル サポート チームが

対応いたします。  

早急な対応が求められる場合には、下記の方法をご利用ください。 

▪ セルフ ヘルプ 

▪ お近くの販売代理店 

http://www.cypress.com/
http://www.cypress.com/?id=2494&source=an79953
http://www.cypress.com/?id=4749&rtID=377
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=software_tools_meta_type%3A532&f%5b2%5d=field_related_products%3A1292
https://secure.cypress.com/myaccount/?id=25&techSupport=1&source=an79953
https://secure.cypress.com/myaccount/?id=25&techSupport=1&source=an79953
http://www.cypress.com/support
http://www.cypress.com/?id=1062
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4 サンプル コード 

PSoC Creatorは多数のサンプル コード プロジェクトを提供しています。

これらのプロジェクトは、図 2に示すように、PSoC Creatorのスタート 

ページからアクセスできます。 

サンプル プロジェクトにより、最初 (空のページ) からではなく完成した

設計で始めるため、設計時間を短縮できます。また、サンプル プロ 

ジェクトは PSoC Creator コンポーネントを様々なアプリケーションに

使用する方法も示します。図 3 に示すようにサンプル コードおよび 

データシートが含まれています。 

図 3 に示す「Find Example Project」ダイアログにはいくつかのオプ 

ションがあります。 

▪ アーキテクチャまたはデバイス  ファミリ  (PSoC 3, PSoC 4, 

PSoC 5LP, および PsoC 6 MCU)、またはカテゴリやキーワード

に基づいてサンプル プロジェクトをフィルターします。 

▪ Filter Options に基づいてフィルターされたリストからサンプル  

プロジェクトを選択します。 

▪ 選択のためにデータシートをレビューします (Documentation 

タブ上で) 。 

▪ 選択のためにプロジェクトのサンプル コードをレビューします。 

コード開発時間を短縮させるために、このウィンドウからコードを

コピーしプロジェクトに貼り付けできます。 

▪ 選択に応じた新規プロジェクト (また、必要な場合は新規ワークス

ペース) を作成します。完成した基本的な設計から始めるため、

設計時間を短縮させます。そのように、設計をアプリケーションに

適合させることが可能です。 

図 2. PSoC Creatorのサンプル コード 

 

図 3. サンプル プロジェクトおよびサンプル コード 

 

http://www.cypress.com/
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5 PSoC 3の機能セット 

PSoC 3 は、図 4 (CY8C38xx デバイス ファミリ) に示すように、CPU とメモリ サブシステム, デジタル サブシステム, アナログ  

サブシステム, システム リソースを含む幅広い機能を備えています。 

詳細については、前の節でリストアップした PSoC 3 ファミリ デバイス データシート, テクニカル リファレンス マニュアル 

(TRM), およびアプリケーション ノートを参照ください。 

図 4. PSoC 3アーキテクチャ (CY8C38xx) 
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下記は PSoC 3 の主な機能の一覧です。詳細については、関連資料、または PSoC 3 デバイス データシートを参照ください。 

▪ 性能 

 DC～67 MHzで動作 

 8ビット 8051 CPU、32個の割り込み 

 24 チャネルのダイレクト  メモリ  アクセス 

(DMA) コントローラー 

 24 ビット、64 タップのデジタル フィルター プロ

セッサ (DFB) 

▪ メモリ 

 最大 64 KBのプログラム フラッシュ 

 エラー訂正コード (ECC) 用の最大 8 KBの追加フラッシュ 

 最大 8KBの SRAM 

 2KBの EEPROM 

http://www.cypress.com/
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▪ デジタル周辺機能 

 最大 4 個の 16 ビット タイマ、カウンタ、PWM 

(TCPWM) 

 I2C、1 Mbpsのバス速度 

 USB 2.0認定済み、フルスピード(FS) 12 Mbps 

 フル CAN 2.0b、16 個の Rx と 8 個の Tx 

バッファ 

 20～24 個のプログラマブルなユニバーサル 

デジタル ブロック (UDB) - 任意数の機能を作

成可能 

▪ 8ビット, 16ビット, 24ビット, および 32ビット

のタイマ、カウンタ、PWM 

▪ I2C、UART、SPI、I2S、LIN 2.0インターフェー

ス 

▪ 巡回冗長検査回路 (CRC) 

▪ 疑似乱数列 (PRS) ジェネレータ 

▪ 直交デコーダ 

▪ ゲート レベルのロジック機能 

▪ アナログ サブシステム 

  8～20 ビットのコンフィギュレーション可能な 

デルタ シグマ ADC 

 4個の 8ビット DAC 

 4個のコンパレータ 

 4個の演算増幅器 (オペアンプ) 

 4 個のプログラマブルな アナログ ブロックで、

以下を作成する: 

▪ プログラマブル ゲイン アンプ (PGA) 

▪ トランスインピーダンス アンプ (TIA) 

▪ ミキサー 

▪ サンプル／ホールド (S/H) 回路 

 CapSense®サポート、最大 62個のセンサー 

 1.024 V ± 0.1%の内部電圧リファレンス 

▪ 多用途 I/Oシステム 

 46～72 個の I/O ピン - 最大 62 個までの汎用 I/O 

(GPIO) 

 最大 8個までのパフォーマンス I/O (SIO) ピン 

▪ 25 mAの電流シンク 

▪ プログラマブルな入力閾値および出力 HIGH電圧 

▪ 汎用コンパレータとして動作可能 

▪ ホット スワップ機能および過電圧耐性 

 GPIOとして使用可能な 2個の USBIOピン 

 任意のデジタルまたはアナログ ペリフェラルから任意の

GPIOへ接続 

 任意の GPIO から LCD 直接駆動 - 最大 46 × 16 

セグメントまで 

 すべての GPIOで CapSenseをサポート 

 1.2 V～5.5 V のインターフェース電圧 - 最大 4 個 

までのパワー ドメイン 

▪ プログラマブルなクロック供給 

 3～62 MHzの内部発振器、3 MHzで精度が 1% 

 4～25 MHzの外部水晶発振器 

 内部 PLLクロック生成 - 最大 67 MHz 

 1 KHz, 33 KHz, 100 KHzの低消費電力内部発振器 

 32.768 KHzの外部時計用水晶発振器 

 12 個のクロック分周器 - 任意のペリフェラルまたは I/O

にルーティング可能 

PSoC 3 のすべての機能については、データシートを参照くだ

さい。 

http://www.cypress.com/
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5.1 PSoCの MCUより優れている点 

図 5に示すように、標準的な MCUは、CPU, ADC, DAC, UART, SPI等のペリフェラル機能, そして汎用 I/Oを含みます。こ

れらはすべて CPU のレジスタ インターフェースにリンクします。MCU 内で、CPU はデバイスの「心臓」です。CPU はセット 

アップ, データ移動, タイミングなどのすべての処理を管理します。CPUがないと、MCUは機能しません。 

図 6に示すように、PSoCは全く違います。CPU, アナログ, デジタル, および I/Oは、プログラマブルなシステムで同等に重要なリ

ソースです。 PSoCの心臓は CPUではなく、システムの相互接続とプログラマビリティです。アナログとデジタル ペリフェラル

は高度に設定可能なマトリックスを介して相互接続しています。これにより、ユーザーはアプリケーションの要件を満たすカスタム

設計を作成できます。PSoC をプログラムして MCU をエミュレートできますが、MCU をプログラムして PSoC を 

エミュレートできません。 

図 5. 標準 MCUのブロック図 

 

図 6. PSoC 3のブロック図 

 

標準的な MCU は、ステート マシンを処理し、タイマをタイミングに使用し、出力ピンを駆動するために、CPU ファームウェアを必

要とします。したがって、機能的パスはたいていいつも CPU を介します。しかし、PSoC を用いると、非同期の平行処理が可

能です。PSoCのコンポーネントが CPUから独立して動作するように設定できます。 

例として、図 6に UARTがない PSoC 3を示します。PSoC Creatorの設計かつテスト済みの UARTコンポーネントを使って、

コンフィギュレーション可能な デジタル ロジック内に必要な数の UARTを作成できます。また、それぞれの UARTが必要とす

るだけの機能を持つように設定可能です。 

5.2 PSoC Creator コンポーネントの概念 

PSoC 設計が成功するための鍵は PSoC Creator IDE です。PSoC Creator では、PSoC ペリフェラルと他のリソースが 

「コンポーネント」と呼ばれる図式要素として表示されます。コンポーネントは回路図にドラッグ & ドロップされ、互いに接続される

ため、設計の段階を簡略かつ高速に実行できます。設計の変更は数回のマウス クリックだけで即座に実現できます。 

例えば、従来の MCUでは、PWMペリフェラルを使用して LED を点滅させるためには、次の操作を行わなければなりません。 

1. PWMに対応したレジスタを位置付け 

2. 要求される PWM周期およびデューティ比に基づいて、PWMレジスタに書き込まれる値を計算 

3. PWMレジスタを設定するために数多くのコード行を書き、ピン ドライブ モードを設定し、PWM出力をピンに接続 

PSoCで同様な機能を実装するには、本アプリケーション ノートの次のセクションで説明するように、ごく簡単な操作です。 
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 ピン コンポーネント: 任意の機能を任意のピンに接続 

PSoC 3は広大な配線構造を含み、ほとんどの機能 (デジタルかアナログ) を任意のピンに接続できます。PSoC Creatorが

提供するピン  コンポーネントを利用すると、わずか数回のマウス  クリックだけで設定を完成させ、PSoC リソースに 

接続し、物理ピンに接続できます。また、ピン コンポーネントの接続を簡単に変更できるため、基板レベルの設計変更を急速

に処理できます。 

 プログラマブルなデジタル リソースに基づくコンポーネント 

PSoC 3 には、ユニバーサル デジタル ブロック (UDB) と呼ばれるプログラム可能なデジタル ブロックがあります。PSoC 

Creatorは UDBから作られた多くのコンポーネントを提供します。UART, SPI, I2C, I2S, タイマ, PWM, カウンタ, CRC, 直交

デコーダ, デジタル ゲート (AND, OR, NOT, XOR など) を始め、他にも多くのものが含まれています。さらに、自分の 

カスタム ステート マシンおよびデジタル ロジックを作り上げることが可能です。 

 プログラマブルなアナログ  リソースに基づくコンポーネント 

PSoC 3 には、スイッチト キャパシタ連続時間 (SC/CT) と呼ばれるプログラム可能なアナログ ブロックもあります。PSoC 

Creator は、プログラマブル ゲイン アンプ (PGA) やトランスインピーダンス アンプ (TIA) のような SC/CT ブロックから作られた 

アナログ コンポーネントを提供します。 

6 はじめての PSoC 3デザイン 

このセクションでは次のことを行います。 

▪ 従来の MCU以上のことができるように PSoCをプログラムするデモンストレーション 

▪ 単純な PSoCの設計をビルドし、それを開発キットにインストールする方法の提示 

▪ PSoC Creator IDEで PSoC設計技術の学習を容易にする詳細な手順の提示 

6.1 始める前に準備するもの 

 PSoC Creator をインストールしましたか？ 

PSoC Creator ホームページから PSoC Creator をダウンロードし、インストールします。インストールに時間がかかることが

あります。詳細については、PSoC Creator Release Notes を参照ください。 

 開発キットを持っていますか? 

表 1に PSoC 3用のすべてのサイプレス開発キットを表示します。他のメーカーのキットも利用できます。 

表 1. サイプレスの PSoC 3キット 

PSoC 3キット PSoC 3デバイスの製品番号 プログラミング 

CY8CKIT-030 CY8C3866AXI-040 プログラマを内蔵 

CY8CKIT-001 CY8C3866AXI-040 MiniProg3プログラムおよびデバッグ キット 

 

 実行中のプロジェクトをご覧になりたいですか？ 

次のセクションで説明する開発過程が必要ない場合、CE203303 から完成したサンプル プロジェクトをご利用できます。そして、 

ビルドおよびプログラムのステップへ進めます。サンプル コードは PSoC 5LP ベースの CY8CKIT-059 向けに設計されます

が、PSoC 3キットのために簡単に修正できます。 

http://www.cypress.com/
http://www.cypress.com/go/creator
http://www.cypress.com/?rID=51577&source=ce95314
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-001-psoc-development-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-002-psoc-miniprog3-program-and-debug-kit
http://www.cypress.com/node/386956
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-059-psoc-5lp-prototyping-kit
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6.2 デザインについて 

このデザインはサンプル コードCE203303、PSoC 3 and PSoC 5LP Breathing LEDに詳しく説明されます。「ブリージング LED」

効果を、初期化後 CPUを使わずにハードウェアだけで実装します。図 7に PSoC Creatorの回路図を示します。 

図 7. ブリージング LEDの回路図 (ピンおよび LEDは CY8CKIT-059用) 

 

6.3 パート 1: デザインの作成 

このセクションは設計過程順に説明します。ハードウェアとファームウェアの両方の設計エントリについて解説します。 

注意事項： これらの手順では、ユーザーが PSoC Creator 3.3 を利用していることを前提にします。全体的な開発過程は、

PSoC Creatorの他のバージョンでも同様ですが、いくつかのダイアログ ボックスに変更があることがあります。 

1. 新しい PSoC Creatorプロジェクトを作成します。 

プロジェクトには、すべてのソース コード、およびターゲットである PSoC 3 デバイスにダウンロードできる 1 つの出力 

モジュールを作成するのに必要なファイルが含まれています。 

A. PSoC Creatorを起動します。 

B. 図 8に示すように、メニューから 

File > New > Project… 

を選択します。 

「Create Project」ウィンドウが開きます。 

図 8. 新しい PSoC Creatorプロジェクトの作成 

 

http://www.cypress.com/
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2. PSoC 3をターゲット デバイスに選択します。図 9を参照ください。 

PSoC Creatorは、自動的に様々なプロジェクト オプションを特定のターゲット デバイスや開発キットに設定できるため、

開発時間を短縮できます。 

A. Target deviceをクリックします。 

B. プルダウン メニューから PSoC 3を選びます。 

C. Nextをクリックします。 

図 9. CY8CKIT-059用の新しいプロジェクトの作成 

  

A 

B 

C 
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3. 空の回路図をプロジェクト テンプレートとして選択します。図 10を参照ください。 

PSoC Creator は、既存のサンプル コードに基づいて新しいデザインを作ることで開発時間を短縮させます。この場合では、

空の回路図から開始します。 

A. Empty Schematicをクリックします。 

B. Nextをクリックします。 

C. 次のダイアログの Workspace name にワークスペースの名前を入力します。1 つのワークスペースにいくつかの

プロジェクトを格納します。プロジェクトは通常ワークスペースに格納されます。 

D. Project name にプロジェクトの名前を入力します。プロジェクト名とワークスペース名は同じでも違っても構いません。 

E. ワークスペースとプロジェクトの Locationを指定します。 

F. Finishをクリックします。 

図 10. 新しい空のプロジェクトの作成 
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プロジェクトが作成されました。いくつかの新しいペインが表示されます: Workspace Explorer、Schematic 

(TopDesign.cysch)、および Component Catalog。 

4. デザインのハードウェア部分をビルドします。 

このステップでは、コンポーネントを Component 

Catalog から回路図にドラッグします。その後、

それぞれのコンポーネントを設定し、互いに接続

させます。 

a. 図 11 のように、Component Catalog 

ウィンドウの Cypress タブで、PWM コン

ポーネントを検索します。 

b. 2 個の PWM コンポーネントを回路図にド

ラッグします (図 7を参照)。 

図 11. PWMコンポーネントの選択 

 

http://www.cypress.com/
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5. 図 12に示すように、PWMコンポーネントを設定します。 

この両方の PWM から方形波の出力が生成されますが、方形波の周波数は少し異なります。この周波数の差により、

LEDで変調されるビート周波数が発生します。 

回路図で、それぞれの PWMコンポーネントをダブルクリックして設定します。 

A. PWM_1の PWM Modeを One Outputにします。 

B. PWM_1に他の変更をしません。OKをクリックしてダイアログを閉じます。 

C. PWM_2の PWM Modeを One Outputにします。 

D. PWM_2の Period値をデフォルト値から少し外れた値に設定します。 

E. PWM_2の CMP Value 1を Period値の約半分に設定します。 

F. PWM_2の変更が完了しました。OKをクリックしてダイアログを閉じます。 

図 12. PWMコンポーネントの設定 

   

6. 表 2に示す追加コンポーネントを Component Catalogから回路図にドラッグして設定します。  

Off-Chipのコンポーネントは必須ではありませんが、デザインの全体的な目的を示すのに役立ちます。 

注意事項: 各コンフィギュレーション ダイアログの Name フィールドは自動的に挿入されますが、他の有効な名前に変更

可能です。コンポーネントの名前は回路図においては唯一なものです。 

表 2. デザイン コンポーネント 

コンポーネント 

コンポーネント カタログ 

デフォルト設定からの変更 タブ グループ 

Logic Low Cypress デジタル > ロジック なし 

Xor Cypress デジタル > ロジック なし 

Clock Cypress システム Frequencyを 5 kHzに設定 

Digital Output Pin Cypress ポートとピン External terminalボックスにチェックを入れる 

Resistor Off-Chip 受動 なし 

LED Off-Chip ダイオード なし 

Ground Off-Chip 消費電力 なし 
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7. ワイヤー ツールを選択して (またはショートカットと

して「w 」を押して ) ロジックを接続します  

(図 13を参照)。 

図 7 に示すように、コンポーネントを接続します。 

図 13. ワイヤー ツールの選択 

 

8. これで、ハードウェアの設計が完成しましたが、ピン コンポーネントを物理ピンに接続させなければなりません。 

使用中の開発キットの LED ピンを選択します。(CY8CKIT-030 の場合、使用されるピンはポート 6 のピン 2 かピン 3 

(P6[2]か P6[3]とも呼ばれる) に選択できます。 

A. 図 14 に示すように、Workspace Explorer ウィンドウで、プロジェクト内の.cydwr ファイルをダブルクリックします。 

すると、デザイン全体リソースのウィンドウ (DWR) が開きます。 

B. Pins タブを選択します。プロジェクトで定義されたピン コンポーネント、およびターゲット デバイスのピンの配置図が

表示されます。 

C. 回路図のピン コンポーネントを所望の物理ピンに接続します。 

図 14. ピンの割当て 

 

9. ここで、数行のファームウェアを書く必要があります。その前に、PSoC Creator が、コンポーネントに関連するすべての 

コードを生成するようにします。 

図 15 に示すように、PSoC Creator のメニュー

から Build > Generate Application を選択し

ます。エラーがなければ、PSoC Creator は 

Generated_Source フォルダにいくつかのコード 

ファイルを生成します。 

図 15. アプリケーションの生成 
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C 
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10. コードを自動生成したファイル main.c に追加します。コードを追加するためのフレームワークがあります。2 個の PWM 

コンポーネントを起動するために追加しなければならないコードは、コード 1 に示すように、ハイライト表示されます。

Workspace Explorerウィンドウで、プロジェクトの main.cファイルをダブルクリックして開きます。 

注意事項: このコードでは、PWMコンポーネントはデフォルトの名前であることを前提にします。PWMコンポーネントをデフォ

ルトでない他の名前に変更する場合、_Start() 関数呼出しでその名前を使用します。 

コード 1. ブリージング LEDのメイン コード 

#include <project.h> 

 

int main() 

{ 

    //CyGlobalIntEnable; /* Enable global interrupts. */ 

 

    /* Place your initialization/startup code here (e.g. MyInst_Start()) */ 

    PWM_1_Start(); 

    PWM_2_Start(); 

 

    for(;;) 

    { 

        /* Place your application code here. */ 

    } 

} 

 

11. 設計過程を飛ばしてこのステップに進んだ場合、以下のようにしてください: 

A. CE203303.zipのサンプル コードのファイルを CE203303からダウンロードし、コンピューターの便利な位置に展開

します。 

B. 9ページの「ステップ 1」に説明したように、PSoC Creatorをダウンロードし、インストールします。 

C. PSoC Creatorで CE203303.cywrkファイルを開きます。 

D. 14ページの「ステップ 8」に説明したように、プロジェクトのピンの割当てが開発キット (DVK) に一致するか否かを確

認します。  

E. Workspace Explorer ウィンドウで、プロジェ

クト名をダブルクリ ッ ク して 、 Device 

Selector を選択し、CY8C3866AXI-040

をターゲット デバイスにします。 

F. 図 16 に示すように、PSoC Creator のメ 

ニューから Build > Build <プロジェクト名

>を選択します。エラーがなければ、プロジ

ェクトはビルドされ、ターゲットの DVK にプ

ログラムできる状態になります。 

図 16. プロジェクトのビルド 

 

http://www.cypress.com/
http://www.cypress.com/node/386956
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6.4 パート 2: デバイスのプログラム 

プログラム過程はすべての開発キット基板で同様です。DVKを設定するために、キット ガイド ドキュメントの説明書に従ってく

ださい。 

1. PSoC Creatorとユーザーの DVKの接続を確認します。 

図 17 に示すように、PSoC Creator のメニュー

から Debug > Select Debug Targetを選択し

ます。 

A. 図 18 に示すように、 「 Select Debug 

Target」ダイアログが表示されます。ターゲッ

トの DVK をクリックします (PSoC Creator

は多くの DVK接続をサポートします) 。 

B. Port Acquireをクリックします。 

図 17. デバッグ ターゲットの選択 

 

図 18. プログラム ターゲットの選択と取得 
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2. ターゲットの DVK上の PSoCに接続します。図 19を参照ください。 

A. PSoC 3をクリックします。 

B. Connect をクリックします。「Target unacquired」メッセージが「Target acquired」になり、ボタンのラベルは

「Disconnect」に変更します。 

C. OKをクリックしてダイアログを閉じます。 

これで、PSoC Creatorはターゲットの DVKと PSoCに接続し、PSoCのプログラムが可能になります。 

図 19. ターゲットの PSoC 3への接続 

  

3. 図 20 に示すように、PSoC 3 をプログラムする

た め に 、 PSoC Creator の メ ニ ュ ー か ら

Debug > Programを選択します。 

4. プログラミングが開始します。図 21 に示すように、

プログラミング状況は PSoC Creator のステー

タス バー (画面の左下隅) に表示されます。 

注意事項: 「This programmer is currently out of 

date」の警告メッセージが表示される場合があります。

プログラマ ファームウェアをアップグレードする方法

については、キットの資料にある KitProg ユーザー 

ガイドをご参照ください。 

図 20. デバイスのプログラム 

 

図 21. プログラミング状態 

 

CY8CKIT-030 DVKでは、赤色の LEDが数秒の間に徐々に完全 ONから完全 OFFの状態に変わります。 
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C 
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7 まとめ 

本アプリケーション ノートは PSoC 3アーキテクチャおよび開発ツールを説明しました。このアプリケーション ノートから得られる最

も重要な内容は、PSoCは単に MCUの代わりではないということです。PSoC 3は、単一のチップ上にコンフィギュレーション

可能なアナログとデジタル ペリフェラル機能, メモリ, および 8051 CPU を集積した、真のプログラマブルな組込みシステム 

オン チップです。 

統合した機能と低リーク電力モードを備えるため、PSoC 3 は低消費電力とコスト効率の良い組み込みシステムとして理想的

な選択です。 

8 関連資料 

表 3に、PSoCと PSoC Creatorの次段階の理解に推奨するシステム レベルの一般的なアプリケーション ノートを示します。 

表 3. 一般的なシステム レベルのアプリケーション ノート 

文書番号 文書名 

AN61290、 

AN88619 

PSoC® 3 and PSoC 5LP Hardware Design Considerations、 

PSoC® 4 Hardware Design Considerations 

AN81623 PSoC® 3, PSoC 4, and PSoC 5LP Digital Design Best Practices 

AN77900、 

AN86233、 

AN90114 

PSoC® 3 and PSoC 5LP Low-power Modes and Power Reduction Techniques、 

PSoC® 4 Low-power Modes and Power Reduction Techniques、 

PSoC® 4000 Low-power Modes and Power Reduction Techniques 

AN68403 PSoC® 3 and PSoC 5LP Analog Signal Chain Calibration 

AN57821 PSoC® 3, PSoC 4, and PSoC 5LP Mixed-Signal Circuit Board Layout Considerations 

AN58827 PSoC® 3 and PSoC 5LP Internal Analog Routing Considerations 

AN73854 PSoC® 3, PSoC 4, and PSoC 5LP Introduction to Bootloaders 

AN60616 PSoC® 3 and PSoC 5LP Startup Procedure 

AN60631 PSoC® 3 and PSoC 5LP Clocking Resources 

AN77835 PSoC® 3 to PSoC 5LP Migration Guide 

AN78175、 

AN89056 

PSoC® 3 and PSoC 5LP IEC60730 Class B Safety Software Library, 

PSoC® 4 – IEC 60730 Class B and IEC 61508 SIL Safety Software Library 

 

表 4 に、PSoC 3 の機能セットのデバイス説明に関連するアプリケーション ノート (AN), サンプル コード (CE), および知識 

ベース記事 (KBA) を示します。 

表 4. PSoC 3機能に関連する資料 

文書番号 文書名 

CPUおよび割込み 

AN60630 PSoC® 3 8051 Code and Memory Optimization 

AN54460 PSoC® 3 and PSoC 5LP Interrupts 

メモリ 

CE95313 PSoC® 3, PSoC 4, and PSoC 5LP Emulated EEPROM Memory 

ダイレクト メモリ アクセス (DMA) 

AN52705 PSoC® 3 and PSoC 5LP – Getting Started with DMA 

AN84810 PSoC® 3 and PSoC 5LP Advanced DMA Topics 

http://www.cypress.com/
http://www.cypress.com/documentation/application-notes/an61290-psoc-3-and-psoc-5lp-hardware-design-considerations
http://www.cypress.com/documentation/application-notes/an88619-psoc-41004200-hardware-design-considerations
http://www.cypress.com/documentation/application-notes/an81623-psoc-3-psoc-4-and-psoc-5lp-digital-design-best-practices
http://www.cypress.com/documentation/application-notes/an77900-psoc-3-and-psoc-5lp-low-power-modes-and-power-reduction
http://www.cypress.com/documentation/application-notes/an86233-psoc-4-low-power-modes-and-power-reduction-techniques
http://www.cypress.com/documentation/application-notes/an90114-psoc-4000-family-low-power-system-design-techniques
http://www.cypress.com/documentation/application-notes/an68403-psoc-3-and-psoc-5lp-analog-signal-chain-calibration
http://www.cypress.com/documentation/application-notes/an57821-psoc-3-psoc-4-and-psoc-5lp-mixed-signal-circuit-board-layout
http://www.cypress.com/documentation/application-notes/an58827-psoc-3-and-psoc-5lp-internal-analog-routing-considerations?source=search&keywords=AN58827
http://www.cypress.com/documentation/application-notes/an73854-psoc-3-psoc-4-and-psoc-5lp-introduction-bootloaders
http://www.cypress.com/documentation/application-notes/an60616-psoc-3-and-psoc-5lp-startup-procedure
http://www.cypress.com/documentation/application-notes/an60631-psoc-3-and-psoc-5lp-clocking-resources
http://www.cypress.com/documentation/application-notes/an77835-psoc-3-psoc-5lp-migration-guide
http://www.cypress.com/documentation/application-notes/an78175-psoc-3-and-psoc-5lp-iec-60730-class-b-safety-software
http://www.cypress.com/documentation/application-notes/an89056-psoc-4-iec-60730-class-b-and-iec-61508-sil-safety-software
http://www.cypress.com/documentation/application-notes/an60630-psoc-3-8051-code-and-memory-optimization
http://www.cypress.com/documentation/application-notes/an54460-psoc-3-and-psoc-5lp-interrupts
http://www.cypress.com/documentation/code-examples/ce95313-emulated-eeprom-memory-psoc-345lp
http://www.cypress.com/documentation/application-notes/an52705-psoc-3-and-psoc-5lp-getting-started-dma
http://www.cypress.com/documentation/application-notes/an84810-psoc-3-and-psoc-5lp-advanced-dma-topics
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文書番号 文書名 

AN61102 PSoC® 3 and PSoC 5LP – ADC Data Buffering Using DMA 

CE95375 
CE95376 

SPI Master and DMA with PSoC® 3 and PSoC 5LP 
SPI Slave and DMA with PSoC® 3 and PSoC 5LP 

デジタル フィルタ ブロック (DFB) 

CE95316 Filter From ADC to VDAC Using DFB with PSoC® 3 and PSoC 5LP 

CE95317 Filter From ADC to VDAC Using DFB in Polling Mode with PSoC® 3 and PSoC 5LP 

I2C 

CE95324 I2C LCD with PSoC® 3 and PSoC 5LP 

CE95314 PSoC® 3, PSoC 4, and PSoC 5LP EZI2C 

USB 

AN57294 USB 101: An Introduction to Universal Serial Bus 2.0 

AN57473 USB HID Basics with PSoC® 3 and PSoC 5LP 

AN58726 USB HID Intermediate with PSoC® 3 and PSoC 5LP 

AN56377 PSoC® 3 and PSoC 5LP – Introduction to Implementing USB Data Transfers 

AN82072 PSoC® 3 and PSoC 5LP USB General Data Transfer with Standard HID Drivers 

AN73503 USB HID Bootloader for PSoC® 3 and PSoC 5LP 

CE95390 USB Audio with PSoC® 3 and PSoC 5LP 

CE95395 USB MIDI with PSoC® 3 and PSoC 5LP 

CE95394 USB HID Mouse with PSoC® 3 and PSoC 5LP 

CE95393 USB Bulk Transfer with PSoC® 3 and PSoC 5LP 

CE95392 USB Bootloader with PSoC® 3 and PSoC 5LP 

CE95396 USB UART with PSoC® 3 and PSoC 5LP 

コントローラー エリア ネットワーク (CAN) 

AN52701 PSoC® 3 and PSoC 5LP – Getting Started with Controller Area Network (CAN) 

CE95282 CAN as Control Node with PSoC® 3 and PSoC 5LP 

CE95283 CAN as Remove Node with PSoC® 3 and PSoC 5LP 

KBA86565 Difference Between Full CAN and Basic CAN Mailbox 

KBA86566 Acceptance Filter Implementation for CAN Receive Message 

KBA86567 Modifying the Full CAN Mailbox’s Identifier in the Program 

ユニバーサル デジタル ブロック (UDB) 

AN82250 PSoC® 3, PSoC 4, and PSoC 5LP – Implementing Programmable Logic Designs with Verilog 

AN82156 PSoC® 3, PSoC 4, and PSoC 5LP – Designing PSoC CreatorTM Components with UDB Datapaths 

CE95295 8-Bit UDB Counter with PSoC® 3 and PSoC 5LP 

CE95384 16-Bit UDB-Based Timer with PSoC® 3 and PSoC 5LP 

CE95323  Hardware Fan Control with PSoC® 3 and PSoC 5LP 

KBA85325 Comparison of Resource Utilization Between PSoC® 3 and PSoC 5LP UDBs and Other Vendor CPLDs 

KBA86336 Just Enough Verilog for PSoC® 

http://www.cypress.com/
http://www.cypress.com/documentation/application-notes/an61102-psoc-3-and-psoc-5lp-adc-data-buffering-using-dma
http://www.cypress.com/documentation/code-examples/ce95375-spi-master-and-dma-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95376-spi-slave-and-dma-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95316-filter-adc-vdac-using-dfb-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95317-filter-adc-vdac-using-dfb-polling-mode-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95324-i2c-lcd-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95314-psoc-3-psoc-4-and-psoc-5lp-ezi2c
http://www.cypress.com/documentation/application-notes/an57294-usb-101-introduction-universal-serial-bus-20?source=search&keywords=AN57294
http://www.cypress.com/documentation/application-notes/an57473-usb-hid-basics-psoc-3-and-psoc-5lp?source=search&keywords=AN57473
http://www.cypress.com/documentation/application-notes/an58726-usb-hid-intermediate-psoc-3-and-psoc-5lp?source=search&keywords=AN58726
http://www.cypress.com/documentation/application-notes/an56377-psoc-3-and-psoc-5lp-introduction-implementing-usb-data?source=search&keywords=AN56377
http://www.cypress.com/documentation/application-notes/an82072-psoc-3-and-psoc-5lp-usb-general-data-transfer-standard-hid?source=search&keywords=AN82072
http://www.cypress.com/documentation/application-notes/an73503-usb-hid-bootloader-psoc-3-and-psoc-5lp?source=search&keywords=AN73503
http://www.cypress.com/documentation/code-examples/ce95390-usb-audio-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95395-usb-midi-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95394-usb-hid-mouse-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95393-usb-bulk-transfer-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95392-usb-bootloader-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95396-usb-uart-psoc-35lp
http://www.cypress.com/documentation/application-notes/an52701-psoc-3-and-psoc-5lp-getting-started-controller-area-network
http://www.cypress.com/documentation/code-examples/ce95282-can-control-node-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95283-can-remove-node-psoc-35lp
http://www.cypress.com/knowledge-base-article/difference-between-full-can-and-basic-can-mailbox-kba86565
http://www.cypress.com/knowledge-base-article/acceptance-filter-implementation-can-receive-message-kba86566?source=search&keywords=KBA86566
http://www.cypress.com/knowledge-base-article/modifying-full-can-mailbox-s-identifier-program-kba86567?source=search&keywords=KBA86567
http://www.cypress.com/documentation/application-notes/an82250-psoc-3-psoc-4-and-psoc-5lp-implementing-programmable-logic?source=search&keywords=AN82250
http://www.cypress.com/documentation/application-notes/an82156-psoc-3-psoc-4-and-psoc-5lp-designing-psoc-creator-components?source=search&keywords=AN82156
http://www.cypress.com/documentation/code-examples/ce95295-8-bit-udb-counter-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95384-16-bit-udb-based-timer-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95323-hardware-fan-control-psoc-35lp
http://www.cypress.com/knowledge-base-article/comparison-resource-utilization-between-psoc-3-psoc-5-and-psoc-5lp-udbs-and
http://www.cypress.com/knowledge-base-article/just-enough-verilog-psoc-kba86336?source=search&keywords=KBA86336
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文書番号 文書名 

アナログ-デジタル変換器 (ADC) 

AN84783 Accurate Measurement Using PSoC® 3 and PSoC 5LP Delta-Sigma ADC 

CE95277 Delta-Sigma ADC in Single-Ended Mode with PSoC® 3 and PSoC 5LP 

CE95271 Delta-Sigma ADC in Differential Mode with PSoC® 3 and PSoC 5LP 

CE95276 Sequencing SAR ADC with PSoC® 3 and PSoC 5LP 

KBA81866 Best Method of Amplification to Get Better Performance from PSoC® 3 and PSoC 5LP Delta-Sigma ADC 

KBA84753 Choice of Reference Voltage for Accurate ADC Measurements in PSoC® 3, PSoC 4 and PSoC 5LP 

デジタル-アナログ変換機 (DAC) 

AN60305 Using PSoC® 3 and PSoC 5LP IDACs to build a better VDAC 

AN64275 PSoC® 3 and PSoC 5LP: Getting More Resolution from 8-Bit DACs 

AN69133 PSoC® 3 and PSoC 5LP Easy Waveform Generation with the WaveDAC8 Component 

CE95397 Voltage DAC with PSoC® 3 and PSoC 5LP 

CE95309 Dithered Voltage DAC with PSoC® 3 and PSoC 5LP 

KBA84732 VDAC8 Output Voltage in PSoC® 3 and PSoC 5 

KBA83238 Driving an External Load using VDAC in PSoC® 3 or PSoC 5 

コンパレータ 

AN60220 PSoC® 3 and PSoC 5LP Multiplexed Comparator 

CE95292 Analog Voltage Comparator with PSoC® 3 and PSoC 5LP 

CE95361 Scanning Comparator Using Internal VDAC with PSoC® 3 and PSoC 5LP 

CE95360 Scanning Comparator Using Common Mode with PSoC® 3, PSoC 4, and PSoC 5LP 

演算増幅器 (オペアンプ) 

CE95339 Operational Amplifier (Opamp) with PSoC® 3 and PSoC 5LP 

プログラマブル アナログ ブロック (SC/CT) 

AN60321 Peak Detection with PSoC® 3 and PSoC 5LP 

AN62582 AM Modulation and Demodulation 

CE95342 Programmable Gain Amplifier (PGA) with PSoC® 3 and PSoC 5LP 

CE95343 Inverting Programmable Gain Amplifier with PSoC® 3 and PSoC 5LP 

CE95383 Transimpedance Amplifier (TIA) with PSoC® 3 and PSoC 5LP 

CE95357 Sample and Hold with PSoC® 3 and PSoC 5LP 

CE95337 Analog Signal Mixer with PSoC® 3 and PSoC 5LP 

CapSense 

AN75400 PSoC® 3 and PSoC 5LP CapSense® Design Guide 

CE95287 CapSense® CSD Using Tuner with PSoC® 3 and PSoC 5LP 

CE95284 CapSense® CSD Design with PSoC® 3 and PSoC 5LP 

I/O 

AN72382 Using PSoC® 3 and PSoC 5LP GPIO Pins 

AN60580 SIO Tips and Tricks in PSoC® 3 and PSoC 5LP 

http://www.cypress.com/
http://www.cypress.com/documentation/application-notes/an84783-accurate-measurement-using-psoc-3-and-psoc-5lp-delta-sigma?source=search&keywords=AN84783
http://www.cypress.com/documentation/code-examples/ce95277-delta-sigma-adc-single-ended-mode-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95271-delta-sigma-adc-differential-mode-psoc-35lp?source=search&keywords=ADC&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95276-sequencing-sar-adc-psoc-5lp
http://www.cypress.com/knowledge-base-article/best-method-amplification-get-better-performance-psoc-3-or-psoc-5-del-sig-adc?source=search&keywords=KBA81866
http://www.cypress.com/knowledge-base-article/choice-reference-voltage-accurate-adc-measurements-psoc-3-psoc-4-and-psoc-5lp?source=search&keywords=KBA84753
http://www.cypress.com/documentation/application-notes/an60305-using-psoc-3-and-psoc-5lp-idacs-build-better-vdac
http://www.cypress.com/documentation/application-notes/an64275-psoc-3-and-psoc-5lp-getting-more-resolution-8-bit-dacs
http://www.cypress.com/documentation/application-notes/an69133-psoc-3-psoc-5lp-easy-waveform-generation-wavedac8-component
http://www.cypress.com/documentation/code-examples/ce95397-voltage-dac-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95309-dithered-voltage-dac-psoc-35lp
http://www.cypress.com/knowledge-base-article/vdac8-output-voltage-psoc-3-and-psoc-5-kba84732
http://www.cypress.com/knowledge-base-article/driving-external-load-using-vdac-psoc-3-or-psoc-5-kba83238
http://www.cypress.com/documentation/application-notes/an60220-psoc-3-psoc-5lp-multiplexed-comparator
http://www.cypress.com/documentation/code-examples/ce95292-analog-voltage-comparator-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95361-scanning-comparator-using-internal-vdac-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95360-scanning-comparator-using-common-mode-psoc-345lp
http://www.cypress.com/documentation/code-examples/ce95339-operational-amplifier-opamp-psoc-35lp?source=search&keywords=CE95339
http://www.cypress.com/documentation/application-notes/an60321-peak-detection-psoc-3-and-psoc-5lp
http://www.cypress.com/documentation/application-notes/an62582-am-modulation-and-demodulation
http://www.cypress.com/documentation/code-examples/ce95342-programmable-gain-amplifier-pga-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95343-inverting-programmable-gain-amplifier-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95383-transimpedance-amplifier-tia-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95357-sample-and-hold-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95337-analog-signal-mixer-psoc-35lp
http://www.cypress.com/documentation/application-notes/psoc-3-and-psoc-5lp-capsense-design-guide?source=search&keywords=PSoC%C2%AE%203&cat=technical_documents
http://www.cypress.com/documentation/code-examples/ce95287-capsense-csd-using-tuner-psoc-35lp
http://www.cypress.com/documentation/code-examples/ce95284-capsense-csd-design-psoc-3-and-psoc-5lp
http://www.cypress.com/documentation/application-notes/an72382-using-psoc-3-and-psoc-5lp-gpio-pins
http://www.cypress.com/documentation/application-notes/an60580-sio-tips-and-tricks-psoc-3-psoc-5lp
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文書番号 文書名 

KBA82883 Controlling a PSoC® 3 and PSoC 5LP GPIO in Firmware 

KBA91716 Differences Between SIO and GPIO Pins in PSoC® 3 and PSoC 5LP 

セグメント LCD 

AN52927 PSoC® 3 and PSoC 5LP - Segment LCD Direct Drive 

CE95368 Segment LCD with PSoC® 5 

 

著者について 

氏名: Nidhin MS 

役職: 上級アプリケーション エンジニア 

経歴: 電子通信工学の学士号を取得してGEC (ガバメント・エンジニアリング大学 - トリチュール、インド) を

卒業しました。技術的関心分野はアナログ信号処理、低消費電力設計、および静電容量タッチ  

センシングです。 

 

http://www.cypress.com/
http://www.cypress.com/knowledge-base-article/controlling-psoc-3-and-5lp-gpio-firmware-kba82883
http://www.cypress.com/knowledge-base-article/differences-between-sio-and-gpio-pins-psoc-3-and-psoc-5lp-kba91716
http://www.cypress.com/documentation/application-notes/an52927-psoc-3-and-psoc-5lp-segment-lcd-direct-drive
http://www.cypress.com/documentation/code-examples/ce95368-segment-lcd-psoc-5
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とはない。従って, Cypress のハードウェアまたはソフトウェア製品に講じられたセキュリティ対策にもかかわらず, Cypress は, Cypress 製品への権
限のないアクセスまたは使用といったセキュリティ違反から生じる一切の責任を負わない。加えて, 本書面に記載された製品には, エラッタと呼ばれる
設計上の欠陥またはエラーが含まれている可能性があり, 公表された仕様とは異なる動作をする場合がある。適用される法律により許される範囲内で, 
Cypressは, 別途通知することなく, 本書面を変更する権利を留保する。Cypressは, 本書面に記載のある, いかなる製品若しくは回路の適用又は使用か
ら生じる一切の責任を負わない。本書面で提供されたあらゆる情報 (あらゆるサンプルデザイン情報又はプログラムコードを含む) は, 参照目的のため
のみに提供されたものである。この情報で構成するあらゆるアプリケーション及びその結果としてのあらゆる製品の機能性及び安全性を適切に設計, 
プログラム, かつテストすることは, 本書面のユーザーの責任において行われるものとする。Cypress製品は, 兵器, 兵器システム, 原子力施設, 生命維
持装置若しくは生命維持システム, 蘇生用の設備及び外科的移植を含むその他の医療機器若しくは医療システム, 汚染管理若しくは有害物質管理の運用
のために設計され若しくは意図されたシステムの重要な構成部分としての使用, 又は装置若しくはシステムの不具合が人身傷害, 死亡若しくは物的損害
を生じさせるようなその他の使用 (以下「本目的外使用」という。) のためには設計, 意図又は承認されていない。重要な構成部分とは, それの不具合
が装置若しくはシステムの不具合を生じさせるか又はその安全性若しくは実効性に影響すると合理的に予想できるような装置若しくはシステムのあら
ゆる構成部分をいう。Cypress製品のあらゆる本目的外使用から生じ, 若しくは本目的外使用に関連するいかなる請求, 損害又はその他の責任について
も, Cypressはその全部又は一部をとわず一切の責任を負わず, かつ Cypressはそれら一切から本書により免除される。Cypressは Cypress製品の本目
的外使用から生じ又は本目的外使用に関連するあらゆる請求, 費用, 損害及びその他の責任 (人身傷害又は死亡に基づく請求を含む) から免責補償され
る。 

Cypress、Cypressのロゴ、Spansion、Spansionのロゴ及びこれらの組み合わせ、WICED、PSoC、CapSense、EZ-USB、F-RAM、及び Traveoは、
米国及びその他の国における Cypress の商標又は登録商標である。Cypress の商標のより完全なリストは、cypress.com を参照のこと。その他の名称
及びブランドは、それぞれの権利者の財産として権利主張がなされている可能性がある。 
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http://www.cypress.com/?id=1062&source=an77759
http://www.cypress.com/products/32-bit-arm-cortex-mcus
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http://www.cypress.com/products/clocks-buffers
http://www.cypress.com/products/interface
http://www.cypress.com/internet-things-iot
http://www.cypress.com/products/memory-products
http://www.cypress.com/mcu
http://www.cypress.com/psoc/
http://www.cypress.com/products/power-management
http://www.cypress.com/products/touch-sensing
http://www.cypress.com/products/usb-controllers
http://www.cypress.com/products/wireless-connectivity
http://www.cypress.com/products/psoc-1
http://www.cypress.com/products/psoc-3
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http://www.cypress.com/?id=2203&source=home_support
https://community.cypress.com/welcome
http://www.cypress.com/projects
http://www.cypress.com/video-library
http://www.cypress.com/blog
http://www.cypress.com/training
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http://www.cypress.com/support
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